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Introduction 

About the ER-900 PC Utility 
The ER-900 Series PC Utility provides basic PC communication functions for SAM4s ER-900 series 
ECRs:  ER-920, ER-940, ER-925, and ER-945.  This utility was designed primarily as a dealer tool to 
save, edit, and download programs.   

Note:  The ER-900 Series PC Utility supports direct onsite serial connection to the ECR or 
Modem communications via a phone line.   

ER-900 PC Utility Features  
 Support Multiple Stores 

 Save and Load ECR programs 

 Convert & Download Logo Bitmaps 

 Edit ECR programs 

 Modem connections over a wired phone line. 

Note:  The ER-900 Series PC Utility was developed to work best with a screen resolution of at 
least 1024 x 768 pixels.   
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Getting Started 

Setting the ER-900 RS-232C Ports 
At the Er-900 Series ECR you must select ‘PC’ as the device that is attached to one of the available 
RS-232C communications ports. 

1. Turn the control lock to the S position (6 o’clock position).  

2. Enter 8 0 (enter 8 1 to program the second port; 8 2 for the optional third port; and 8 3 for 
the optional fourth port) and press the SUBTL key. 

3. Enter 1 and press the X/TIME key. 

4. Enter the numeric value that represents the baud rate setting that matches the setting in 
the Er-900 PC Utility. (0=9600; 4=19,200; 6=57,600) 

5. Enter 5 and press the X/TIME key.  (The complete RS-232C option chart follows for 
your reference.)   

6. Enter 1 (the value for PC) and press the CASH key.   

7. Repeat from step 2 for additional options you wish to program.  

8. Press CASH to exit the program.   

 

 

 

 

 

 

 

 

 

 

XTIMEOPTIONSUBTL0 8 CASH VALUE CASH 

XTIMEOPTIONSUBTL1 8 CASH VALUE CASH 

Port 1 
(standard) 

Port 2 
(standard) 

XTIMEOPTIONSUBTL2 8 CASH VALUE CASH Port 3 
(option) 

XTIMEOPTIONSUBTL3 8 CASH VALUE CASH Port 4 
(option) 
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RS-232 Option Chart 
Address  Option Value Selection 

1 Baud Rate 0 9600 BPS 
1 1200 BPS 
2 2400 BPS 
3 4800 BPS 
4 19200 BPS 
5 38,200 BPS 
6 57,600 BPS 
7 115,200 BPS 

2 Parity 0 NONE 
1 ODD 
2 EVEN 

3 Data Bits 0 8 BITS 
1 7  ITS 

4 Stop Bits 0 1 BIT 
1 2 BIT 

5 Device Function 0 NONE 
1 PC 
2 SCALE 
3 Remote Journal (TVS 

Interface) 
4 Remote Printer
5 Liquor Dispenser
6 Scanner 
7 COIN 
8 EFT Device 
9 Pole Display 
10 PDC 

6 Initial Feeding Line KP 0 - 20  

7 End Feeding Line KP 0 - 20  

8 Initial Feeding Line Slip 0 - 20  

9 Print Line On Guest Check 0 - 50  

10 Scale Type 0 NCI 
1 CAS 
2 CAS Ounce 
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Address  Option Value Selection 

11 Printer Type 0 NONE 
1 SAM4s ELLIX10
2 SAM4s ELLIX20
3 SRP-270/270, SNBC M280
4 SRP-350,  

SNBC R580/2002NP/880NP 
5 CITIZEN 3550
6 CITIZEN 810
7 CITIZEN 230
8 EPSON TM T88-2
9 EPSON U200
10 EPSON U295
11 EPSON U300
12 EPSON U325
13 EPSON U375
14 STAR SP-200
15 STAR SP-298
16 STAR SP-300
17 STAR TSP-200

12 Display Type 0 EPSON 
1 ICD 

 



 

ER-900 Series PC Utility v1.5 Getting Started  •  9 

Preparing the ER-900 for Communications 
The register must be ready for communications: 

• Connect the register directly to the PC with the appropriate serial cable.  See “Cabling 
Diagrams” on page 47.   

• The register power must be on. 

• A clerk must be signed on.  

• The register cannot be inside of a transaction or other operation.  

• The key lock can be in any position other than OFF.   

Installing the Utility 
The ER-900 PC Utility can be downloaded from the ER-900 Series page in the Dealer Area on the 
CRS web site: https://www.crs-usa.com/products/    

1. Download and extract the ER900_PC-Utility to a folder on you PC. 

2. From Windows Explorer, locate the file: Setup900.exe.   

3. Double click the file to open the installation dialog box.   

4. Follow the installation wizard instructions to complete the installation.    
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Starting the PC Utility 
1. Choose Start, Programs, SHC PC Utility and then 900PC.  The Store Setting dialog 

box displays.   
Note: If you are starting the utility for the first time, you will be prompted to add a store.  
Enter the Store Name and press OK.    

2. Select the store you wish to open from the Store Settings drop-down list box and click the 
Close button.  The ER-900 Series PC Utility main screen is displayed.   

 

Note that the setup information for the selected store appears on the bottom of the main screen.  
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Store Settings 
There is no limit to the number of stores you can save with the ER900 PC Utility.  If you are starting 
the utility for the first time, you will be prompted to first add a store.  Enter the Store Name and press 
OK. The Store Setting dialog screen displays. 

If you have more than one store saved, select the store you wish to open from the Store Setting drop-
down list box. 

The Store Setting Dialog Box 
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Key Type 
You must select the correct keyboard type that corresponds with the register you are using:   

• Select 63-key keyboard for the ER-915.   

• Select the 150-key flat keyboard for the ER-920 or ER-940.  

• Select the appropriate 98-key keyboard for the ER-925 or ER-945.  

98-Key (Double) 
Select 98-Key (Double) for the default raised keyboard with doublewide keys.  

1 8 15
FEED JOURNAL 

FEED #/ NS TAX 1 CLERK

2 9 16
RETURN CANCEL VOID ERROR

CORR RA 

3 10 17
CLEAR PLU X/ TIME %1 PO 

4 11 18
7 8 9 CHECK CHARGE

1 

5 12 19
4 5 6 SUBTOTAL 

6 13 20
1 2 3 

CASH 
TEND 

7 14 21 0 00 . 

 

98-Key  
Select 98-Key for the expanded raised keyboard.  

1 8 15 22 29 36 43 50 57
FEED JOURNAL 

FEED #/ NS TAX 1 CLERK

2 9 16 23 30 37 44 51 58

RETUR
N CANCEL VOID ERROR

CORR RA 

3 10 17 24 31 38 45 52 59
CLEAR PLU X/ TIME %1 PO 

4 11 18 25 32 39 46 53 60
7 8 9 CHECK CHARGE

1 

5 12 19 26 33 40 47 54 61
4 5 6 SUBTOTAL 

6 13 20 27 34 41 48 55 62
1 2 3 

CASH 
TEND 

7 14 21 28 35 42 49 56 63
0 00 . 
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Selecting a Store 
♦ Select the working store when you start the utility.   

♦ To change the working store after the utility has been started, choose Setup Store from 
the Setup menu and select a different store from the drop-down list box.   

Adding a Store 
♦ Choose Add Store from the Setup menu.  At the Add Store dialog, enter the store name 

and click OK.  At the Store Setting dialog, select the model, keyboard type, PC port, 
baud rate and click the Close button.    

Removing a Store 
♦ Choose Remove Store from the Setup menu.  At the Remove Store dialog, select the 

store name to remove and click OK.   
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Upload/Download Programs 

UpProgram 
 

You must upload a register program to your PC before program edit functions are allowed.   

♦ Select All Program (recommended) to upload the entire register program or select the 
specific program segment you wish to upload from the UpProgram(ECR->PC) menu.   

 



 

ER-900 Series PC Utility v1.5 Upload/Download Programs  •  15 

DownProgram  
Use the Down Program to send program changes to the ER-915. Downloading a program from the 
ER-900 PC Utility to the ECR will overwrite the existing register program. If you are loading 
program files to a new register, you must enter the memory allocation manually at the register before 
downloading, we cannot download memory allocation from the utility.  

 
Note: You will need to verify that the memory allocation settings on the register are set to 
accept the store program file being downloaded. 

 

♦ Select the program segment you wish to download from the DownProgram(PC->ECR) 
menu or select All Program to download the entire register program (not including 
Preamble and Postamble images, the images are downloaded separately.)   
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Edit Programs 

Procedures 
With the exception of memory allocation, all register programs can be edited with the ER-900 PC 
Utility.  You will find programming options neatly organized on dialog boxes, making option 
programming on the PC Utility more efficient than programming options at the register.   

 
Note: You must upload a program before program edit functions are allowed.   

 

1. To edit a program, choose the appropriate program from the EditProgram menu.  An 
example of each program dialog box is shown in this chapter.   

2. After edits are completed, click Save to exit and save changes, or click Cancel to exit 
without saving changes.   

Tips 

• Each individual Store’s data is located in a separate folder within the main ER-900PC 
folder on your local drive.   

• If you are building a new register program based upon an existing store, you can copy an 
existing store’s program files to a new store folder.  It is often more efficient to modify an 
existing program than to start over with a new one.   

• If you are building a large PLU file with identical (or similar) options for each PLU, you 
may find the from/to PLU programming at the register useful.  For example, you can first 
program the identical options for a range of PLU’s at the register.  Then upload the PLU 
program with the utility.  Use the utility to program descriptors, prices and make 
adjustments to each PLU individually.  Finally, you can download the completed 
program to the register.   

• If you have questions regarding the meaning of ECR features and options, refer the ER-
900 Series Operator’s and Programming manual for an explanation of your program 
options.   
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Program Edit Screens 
From the EditProgram menu, select a specific program area to edit that part of an existing SAM4s 
ER-900 series ECR program.  Remember that the options in this program allow you to edit the same 
program options that you set on a standalone ER-900 through the register's keyboard.   

Definitions about the meaning of the specific options on the various programming screens are best 
answered by referring to the SAM4s ER-900 Operator’s and Program Manual. 

 
Note:  When editing descriptor fields, you can make bold characters print on the ECR by entering a 
tilde (∼) before each character that you wish to be bold.  Each bold character occupies two character 
positions.   
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PLU 
The PLU file is maintained here.  Refer to the SAM4s ER-900 Operator’s and Program for a 
complete description of the PLU program options.   

 
Simply click on the PLU you wish to edit from the list of PLU’s and edit the Descriptor, Group 
assignment, Price, and other options as needed. Click on SAVE when you have finished editing. 

 

You can also click in the PLU CODE box and enter the number of the number of the PLU you wish 
to edit then press the enter key on your keyboard. That PLU will display, edit the PLU as needed, 
click SAVE when you have finished editing. 

 

If you are entering in scanned items into the database, click in the PLU CODE box and scan the 
product you want to add to the PLU database. Edit the PLU as needed, click SAVE when you have 
finished editing. 

When all items are added and edited as needed, press EXIT to return to the main menu screen. 
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Groups 
You can program the descriptor and options for each group.  (The number of groups is determined in 
the register's memory allocation, with a maximum of 99 groups.)   

Select a group from the list to edit the options as needed for that group; refer to the SAM4s ER-900 
Operator’s and Programming Manual for a complete description of your program options.   

Click the SAVE button when you have finished editing your groups to return to the main menu 
screen. 

 

Tax 
Each of the 4 possible taxes can be set for an add-on percentage, tax table or VAT.  Tax 4 has the 
additional option to be set as GST Taxable as well. Follow the instructions on the screen, or refer to 
the SAM4s ER-900 Operator’s and Programming Manual for a complete description of your program 
options.   
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System Option 
Each system option can be enabled or disabled; check the options you want to enable or uncheck to 
disable the option. Refer to the SAM4s ER-900 Operator’s and Programming Manual for a complete 
description of your program options.   

 

Print Option 
Each print option can be edited.  Check the option to enable that option or uncheck to disable the 
option. Refer to the SAM4s ER-900 Operator’s and Programming for a complete description of your 
program options.   
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Function Key 
You can program the different options for each function key.  Follow the instructions on the screen, 
or refer to the SAM4s ER-900 Operator’s and Programming Manual for a complete description of 
your program options.   

   

Clerk  
Clerk options are set here.  The number of clerks is determined by the memory allocation set in the 
ECR. You can allocate memory for a maximum of 99 Clerks.  

Follow the instructions on the screen, or refer to the SAM4s ER-900 Operator’s and Programming 
Manual for a complete description of your program options.   
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Logo/Descriptors 
You can program a custom preamble, postamble messages to print on customer receipts. You can also 
program the check endorsement message and DataTran message.   

Unique descriptors for certain financial and clerk report totals can be programmed here as well.   
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PLU Stock 
Upload stock from the ECR first.  All PLU’s flagged as an Inventory Item will populate this screen.  
For stock items, edit quantities as needed, and then download to the ECR.   

1. Choose Stock from the EditProgram menu.  The PLU Stock dialog box displays with a 
list of all PLU’s flagged as an Inventory Item and their current stock quantities. 

2. You can edit stock quantities here; two decimal places is assumed on quantities. (To enter 
a quantity of 100 you need to enter 10000 or enter quantity with the decimal 100.00). 

3. Press SAVE after entering your quantity. Continue editing as necessary. 

4. When editing is complete, click Exit. These quantities can then be sent to the register 
from DownProgram (PC->ECR) menu. 
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NLU 
NLUs are keys on the keyboard (like traditional department keys) used to access specific PLU’s.  
NLU#1 through NLU#300 are available for assignment to the keyboard.  

On the default keyboard, the ER-925/ER-945 ECRs has 21 NLUs and is expandable to 63 NLUs.  
The ER-920/ER-940 has 100 NLUs.  Each NLU key is assigned the same corresponding PLU 
number, i.e. NLU key number one is assigned PLU #1.   

However, with this program you can assign any PLU number you wish to any one of the NLU keys.  
PLU’s must be programmed into the database before you are able to assign the PLU to the NLU key. 

 
 

1. Use the scroll box at the right of the screen to view all the NLUs. 

2. Click on the NLU you wish to edit, the PLU list displays.  

3. Scroll through the PLU list and click on the PLU you want to assign to the selected NLU key 
or press CANCEL to not change the current PLU/NLU assignment. 

4. Click SAVE to save changes and return to the main menu.    
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Macro 
The Macro programming screen allows easy programming of Macros using the keyboard layout 
display.  

Simply select the Macro number from the top row of the screen and press the keystrokes for the 
Macro from the display. As shown in the example below; Macro 2 was setup for a $20 speed Tender 
key by pressing 2 0 00 CASH. 

 
 

If you make a mistake during Macro programming you can clear an entry by pressing the CLEAR 
CURR button or press the CLEAR ALL to clear all keystrokes and begin anew.  

When you have completed the programming for your Macro’s press the  icon to save your edits.  

Press EXIT to return to the main screen of the ER-900 PC Utility. 
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Key Layout 
The Keyboard Layout screen allows you to edit the keys on the keyboard, change key assignment and 
design a key sheet to be printed for the register keyboard (Requires 11” x 13” paper). 

Notes:   

• Use the scroll bars to view the entire keyboard.   
• The “&” symbol is reserved.  If you wish to use and “&” symbol in the layout, enter 

“&&”.  On the keyboard layout it will display as “&”. 

 
Screen shown is Expanded Raised keyboard 

Select a key on the layout screen to edit that key.  

        
Enter a new descriptor for the key, max is 10 characters per line.  
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You can also assign a different function key to the key location. 

Select the Key you wish to change by clicking on the desired key, then click on the KEY CODE 
button. 

    
Scroll through the list to the key you wish to assign; click on the key to make the new assignment. 

Select a key color if desired by clicking on the KEY COLOR button. 

   
 

  

Choose the key color you want from the color 
palette, then press OK.  
 

The key code list will appear as shown here. 

You can also create custom colors for 
your keyboard.  
 
Custom colors can be saved to allow use 
on other keys on the keyboard layout.  
 
Note: custom colors are saved only for 
the current keyboard layout editing 
session.  
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To select a different font, click on the SELECT FONT button.  

 
Press OK when you have finished editing. 

 

Save your changes by pressing the  save icon; then exit by pressing the X. if you exit without 
saving you will get a prompt:  

 
Press Yes to save your keyboard edits.  
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Port  
Set options for the communication ports when you are connecting optional hardware to the register.  
Follow the instructions on the screen, or refer to the SAM4s ER-900 Operator’s and Programming 
Manual for a complete description of your program options.   

 

Mix & Match 
1. Choose Mix and Match from the EditProgram menu.  The appropriate Mix and Match 

dialog box displays:   

 
2. You can give the Mix & Match discount a specific name/descriptor.  Set the trip level to 

indicate how many items to ring before the discount is applied.  Set the discount amount in 
the price field.  (As shown above, a $1 discount will apply after three items are registered.)   

3. Click OK when finished editing the Mix & Match discounts to save changes and return to the 
main menu.     
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Etc. – Tare Weight / Age Verification / Drawer Limit / Check Change 
Limit / Machine Number / Datatran No Sign setting 

 

Tare Weight 
You can pre-program five tare weights, representing the weight of different containers.  When you 
place an item and a container on optional scale, you can enter the tare number to automatically 
subtract the pre-programmed tare weight.  

Age Verification  
Up to five different age categories can be created for age restricted items, for example tobacco 
products could be restricted at age 18 and alcohol products restricted at age 21.  The age entries are 
made with this program.  In addition, you will need to use the Group program to define the items that 
will be restricted.   

Drawer Limit 
You can set a cash-in-drawer limit.  When cash in drawer exceeds the limit, a warning will display on 
the screen.   

Check Change Limit 
Use this program to set the maximum amount of cash that can be returned when a check is tendered 
for an amount greater than the amount of the sale. 

Machine Number 
The machine number is printed on the register receipt.  Program a machine number so that any receipt 
or journal can be identified with the store or register where the transaction took place. 

Datatran No Sign 
No signature required if EFT transaction is under xxxx (i.e. if 2000 is set here, no signature is 
required on EFT transactions under $20.00.) 
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Memory Allocation 
Note:  Memory allocation can be viewed in the ER-900 PC Utility but you cannot edit the 
allocation settings.   
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Reports 

Collecting Reports 
Reports cannot be polled with the ER-900 Series PC Utility.  However, reports can be saved to an 
SD card at the register.  SAM4s ER-900 series reports are saved to the SD card in .RPT format.  
These files are not ASCII and cannot be directly read by a report editor.  However, with this 
utility, you can view the report data, export it to Microsoft Excel, and/or export it to a text file. 

Saving Reports to an SD Card 
All reports saved in the same procedure.  Reports saved are the current X1 readings.   

1. At the ECR, turn the control lock to the S position (the 6 o’clock position). 

2. To backup Reports to SD, enter 1 0 1, press the SUBTOTAL key. 

 1 SUB 
TOTAL0 1 

 

Report File Conventions 
Saved reports are stored in a folder named with the current date, located in a folder under the store 
name.  For example:   

 SD\ER-900\REPBACK\Storename\20111130 

Where 20111130 is the date the reports were saved, November 30, 2011.   

Reports listed in this folder are named using the following convention: 

C L K 0 1 1 3 2 . r e p  

      Report type: Clerk (CLK), financial 
(FIN), PLU, group (GRP) 

      0=Daily X1; 1=Period-to date X2 

      Time in 24-hour format 
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ViewReport 
1. Select the type of report you wish to view from the ViewReport menu. 

 
2. The File Associate dialog displays.  Click the Browse ( … ) button to locate the report you 

wish to view.   
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3. Select the report you wish to view.  Note that report you select must match the type of report 
you selected from the menu.  For example, if you selected PLU from the ViewReport menu, 
you must select a report file that begins with the text “PLU …”; if you selected FINANCIAL 
from the ViewReport menu, you must select a report file that begins with the text “FIN…” 

 
4. Click Open.  The selected report displays.   
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5. From the report window, choose: 
 
Print:  to print the file at your printer 
Export to Excel: to save the report in text (.xls) format 
View on Excel: to open Excel and view the file 
Export to Text:  to save the report in Excel (.txt) format 
File Associate:  to select a new financial report 
 

6. Choose Setting to select zero skip options.  Click OK to close the dialog and return to the 
financial report window.   

 
7. Close:  to exit. 
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Utility 
The Utility menu provides the following options:   

• Select Convert Logo Image from the Utility menu to Convert Logo Images to be used as the 
pre-amble/post-amble image.  See “Prepare & Load Bitmap Logos” on page 37.  

• Select PLU PGM TO EXCEL or PLU EXCEL TO PGM to Export/Import PLU Program 
between the 900pc Utility and Excel.  See “Import/Export PLU Files” on page 41.   

• Select Check Status to test the connection status from the 900PC Utility to the register.  
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Prepare & Load Bitmap Logos 

Preparing a Graphic Logo Bitmap for an ER-900 
You can load a preamble and postamble image for your ER-900 receipt.  Before loading, the images 
must be converted by the PC Utility to .img format.  After conversion, they can be loaded directly by 
connecting a PC to the ER-900 or by copying the images to a SD card and loading (or saving the 
image) using the SD utility program described here.   

The information here was derived from a version of MS Paint on Windows XP, your version of Paint 
may appear differently but the same principles explained here will still apply.  

 

Note that after loading the images, you must set Print Options #21 and #22 to activate the image 
printing.   

1.  Preparing a Graphic Logo Bitmap for an ER-900 Series 
The image must be black/white, 384 x 192 pixels, and 10 Kbytes or less in size. 

1. Open MS Paint. 

2. Open the image file you wish to use.   

3. Choose Attributes from the Image menu.  The Attributes dialog box displays. 

 
4. The image dimensions must be no larger than 384 pixels wide by 192 pixels high.  If the 

image size in pixels is greater than the maximum, you must resize your image.   

a. Click OK to exit the Attributes dialog. 

b. Select your image.  (Choose Select All from the Edit menu.) 
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c. Using the handles of the selected image, resize the image.  Keep the image in the 
upper left corner of the screen.   

d. Choose Attributes from the Image menu.  The Attributes dialog box displays again.  
Enter 384 in the Width field; enter 192 in the Height field; select Pixels as the unit.  
Click OK to exit the dialog box.   

e. Your image will be cropped to the 384 x 192 pixel size.  If you cropped part of the 
image you wish to keep, you can undo (Ctrl + Z) and try again.  You may have to 
experiment a bit to resize the image inside the 384 x 192 pixel limit.   

5. After the image is sized, select Black and white in the Attributes dialog. 

6. Save your image as type “Monochrome Bitmap (*.bmp,*.dib)” and confirm that the size 
is 10k or less.  If you resized your original image, rename it when you save (original size 
may be retained with the original image.)  

2.  Use the PC Utility to Convert the Image 
1. Install the ER-900 PC Utility on your PC. 

2. At your PC, start the ER-900 PC Utility.  (Select Start, Programs, SHC PC 
UTILITY, ER-900 PC UTILITY.)  The Store Setting dialog box displays.   

3. If you are starting the ER-900 PC Utility for the first time, you must define a store 
name, or if a store is already defined, you can select the store from the drop-down list.  
After the store is defined or selected, click Close.  The PC Utility program starts.   

4. Move the .bmp logos you wish to use into the store directory  
(i.e. C:\ER-900PC\storename.) 

5. At the PC Utility, choose Convert Logo Image from the Utility menu.  The Bmp 
dialog box displays.   

6. Click FILE OPEN.  Select the bitmap image you wish to use from the Open dialog 
and click the Open command button.  
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7. Click the SAVE AS PRE IMG or SAVE AS POST IMG button. 

 
8. When the image is selected, click OK.  Verify that the message “Save As 

UserPre.Img” or “Save As UserPost.Img” displays.  If the file is too large, and cannot 
be loaded, the message “File Size Error” displays.   

3.  Copy the Images to an SD Card 
The PC Utility will create two image files:  

• USERPRE.IMG 

• USERPOST.IMG 

The image files will be saved in the store folder on your PC at: 

 C:\ER-900PC\Store Name 

Copy the mages to the following path on your SD card: 

 SD\\ER900\PgmBack\Store Name 

Important:  In the path:  C:\ER-900PC\Store Name, the store name is the name you have 
defined as the store in the PC Utility.  Note:  You must use the same store name in the ER-900 
Series ECR at System Option #30.  

4.  Load the Images by SD Card 
Insert the SD card in the register’s SD slot.  Note:  The SD slot is located in the printer 
compartment of the ER-900.  Remove the security screw to access the slot.   

1. Turn the control lock to the S position. 

2. To load the Preamble Image to the register from the SD card, enter 1 2 0, press the 
SUBTOTAL key. 

 0 SUBTL2 1 
 

3. To load the Postamble Image to the register from the SD card, enter 1 3 0, press the 
SUBTOTAL key. 

 0 SUBTL3 1 
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5.  Saving Images from an ER-900 to an SD Card 
1. Insert the SD card in the register’s SD slot.  Note:  The SD slot is located in the printer 

compartment of the ER-900.  Remove the security screw to access the slot.   

2. Turn the control lock to the S position. 
3. To save the Preamble Image from the register to the SD card, enter 1 2 1, press the S

UBTOTAL key. 

 1 SUBTL2 1 
 

4. To save the Postamble Image from the register to the SD card, enter 1 3 1, press the 
SUBTOTAL key. 

 1 SUBTL3 1 
 

 

Printing the Logo Image – ER-900 Settings 
Two addresses in Print Option Programming affect graphic logo printing:  

Option #28 – Add the value of 1 to address 28 if you wish to print the pre-graphic logo on the 
receipt.  Add the value of 2 to address 28 if you wish to print the post graphic logo on the 
receipt.   

Option #29 – Add the value of 1 to address 29 if you wish to print the pre-graphic logo on the 
guest check.  Add the value of 2 to address 29 if you wish to print the post graphic logo on 
the guest check.   

Print Option Flowchart (P Key Lock Position)  

 
 

 

 

 

 

 

 

Status

Option #

SBTL X/TIME  CASH 

Repeat for each 
Print Option 

  SBTL 0 4 
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Import/Export PLU Files 

PLU PGM to Excel/PLU Excel to PGM Utilities 
This feature of the SAM4s ER-900 PC Utility is found under the Utility tab.  Select “PLU PGM TO 
EXCEL” or “PLU EXCEL TO PGM”.   

• When the “PLU PGM TO EXCEL” utility is run, the Excel file is place into the folder:  
C:\ER-900PC\Storename.  The file is named PLU.csv.   

• When the “PLU EXCEL TO PGM” utility is run, the PLU.csv file in the folder:  C:\ER-
900PC\Storename will replace the PLU file and become the active PLU file for the store.  

PLU Key for CSV Import/Export 
 
 

 

Example of Exported CSV File (in Excel):
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Excel PLU.csv Key 
Column on PLU.csv Corresponding Option 

A PLU CODE
B DESCRIPTOR
AJ PRICE/HALO 1
AK PRICE/HALO 2
F PRESET
G PRESET OVERRIDE
H TAXable By: 1
I TAXable By: 2
J TAXable By: 3
K TAXable By: 4
L FOOD STAMP ELIGIBLE
M NEGATIVE ITEM
N HASH
O SINGLE ITEM
P NON-ADD # COMP.
Q GALLONAGE ITEM
R INVENTORY ITEM
S DISABLE
T SCALEABLE
U AUTO SCALE
V CONDIMENT
W COMP. CONDIMENT
X PRINT ON RECEIPT
Y PRINT PRICE ON RECEIPT 
Z PRINT ON CHECK

AB PRINT PRICE ON CHECK 
AC DISABLE PROMO
AD COUNTER NOT RESET
AE PRESET OVERRIDE IN       

MANAGER CONTROL
AF DISABLE VOID AND 

RETURN
AG AUTO TARE
C GROUP # 1 (1-20)
D GROUP # 2 (1-20)
E GROUP # 3 (1-20)

AH PLU LINK CODE
AI MIX & MATCH #

*AA column in the PLU>csv file is always “Y”.  
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PLU Key Viewed on Utility PLU Program Window 
 

 

A
B

H

E

G

J K

L

C
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D

F
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N
P
R

Y
X
V
T
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M
O
Q
S
U
W
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AD
AB
Z

AJ

AK

AE
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Import Note – Notation of Large PLU Numbers 
Using default Microsoft Excel™ settings, numbers exceeding 12 digits will display in scientific 
notation as shown in the sample sheet below: 

 
Caution:  If you are editing a PLU.csv file in Excel, and you are using large PLU numbers (such as 14-digit 

UPC numbers), you must take care to change the formatting of the number in Excel, so that the 
correct PLU number is sent to the PLU file.   

To Change PLU Number Display in Excel 
1. On the Excel spreadsheet, select column “A” (the PLU number column). 

2. Choose Cells from the Format menu.  The Format Cells dialog box displays with the 
Number tab selected.  Note the Category selected is “General”.   
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3. Select the ‘Number” category and set the Decimal places field to “0”.   

 
4. Click OK to save the settings.  Note the large number now displays completely, without 

scientific notation.   
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Version 
Select Version and then 900PC Version to display Utility version information.   
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Appendix 

Cabling Diagrams 
You can configure cables yourself with the diagram provided here, or you can order the appropriate cables from 
CRS Parts at 1-800-333-4949.   

Direct Connection 
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Manual Revision Record 

Edition Date Published Revision Contents 
v1.0 12/12/2011 Added ViewReport Menu functions. 
v1.1 4/2/2013 Keyboard Layout Note added. 
v1.2 4/18/2013 Added new keyboard selections available at utility version 

01.015 
v1.3 5/18/2015 Updated screen shots. 
v1.4 12/7/2016 Updated content, defined edit screens.  
v1.5 7/25/2018 Added key Type selection for ER-915 

   
   
   

 
 

 


